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Topics to be covered 

1) Windows 

2) MS Word 

3) MS Excel 

4) MS Powerpoint 

5) Internet 



  

WINDOWS 

A computer is an electronic device that manipulates information, or data. It 

has the ability to store, retrieve, and process data. You may already know that 

you can use a computer to type documents, send email, play games, 

and browse the Web. You can also use it to edit or 

create spreadsheets, presentations, and even videos. 

Hardware is any part of your computer that has a physical structure, such as 

the keyboard or mouse. It also includes all of the computer's internal parts, 

which you can see in the image below. 

Software is any set of instructions that tells the hardware what to do and how 

to do it. Examples of software include web browsers, games, and word 

processors. 
 

MS WORD 

1.Home 

Home Tab in Microsoft Word is the default tab for editing and formatting the 

document in MS Word. The ribbon of Home Tab in Microsoft Word is divided into 

multiple sections with the name Clipboard, Font, Paragraph, Styles & Editing. 

The detailed explanation about Home Tab in Microsoft Word is given below. 
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2.INSERT TAB  

Insert Tab in Microsoft Word is use for inserting the objects in the documents, 

such as – pages, charts, pictures, symbols, tables, shapes hyperlinks etc. The 

ribbon of Insert Tab in Microsoft Word is divided into multiple sections with the 

name Pages, Tables, Illustrations, Links, Header & Footer, Text and Symbols. The 

detailed explanation about Insert Tab in Microsoft Word is given below. Insert Tab 

in Microsoft Word is use for inserting the objects in the documents, such as – 

pages, charts, pictures, symbols, tables, shapes hyperlinks etc. The ribbon of 

Insert Tab in Microsoft Word is divided into multiple sections with the name 

Pages, Tables, Illustrations, Links, Header & Footer, Text and Symbols. The 

detailed explanation about Insert Tab in Microsoft Word is given below. 
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3.DESIGN 

The template or the design in which you want your document to be created can 

be selected under the Design tab. choosing an appropriate tab will enhance the 

appearance of your document 

 Themes 

 Page Background 

 



  

4.PAGE LAYOUT 

Page Layout Tab in Microsoft Word is use for document page settings like 

appearance of page, page orientation, page size, page margins, page effect, border 

etc. The ribbon of Page Layout Tab in Microsoft Word is divided into multiple 

sections with the name Themes, Page Setup, Page Background, Paragraph and 

Arrange. The detailed explanation about Page Layout Tab in Microsoft Word is 

given below. 
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5.REFERENCES 

Reference Tab in Microsoft Word is use to create the table of contents, images 

caption, cross –references, footnotes, citation & bibliography etc. The ribbon of 

Reference Tab in Microsoft Word is divided into multiple sections with the name 

Table of Contents, Footnotes, Citations & Bibliography, Captions, Index and Table 

of Authorities. The detailed explanation about Reference Tab in Microsoft Word is 

given below. 
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6.MAILING TAB 

Mailing Tab in Microsoft Word is use for creating envelopes, labels and Mail 

Merge. Mail Merge is a feature for sending a letter to the multiple recipient at a 

time with separate details like address and greetings lines. It is a most useful 

feature in offices or companies for sending any information to multiple employees 

at a time. Alternatively we can use this feature to create multiple payslips or id 

cards at a time with separate details. 
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7.REVIEW TAB 

Review Tab in Microsoft Word is use for checking spelling & grammatical 

mistakes in the document, write comments, track changes if the document 

modified, comparing document with another and document protection etc. The 

ribbon of Review Tab in Microsoft Word is divided into multiple sections with the 

name Proofing, Comment, Tracking, Changes, Compare and Protect. The detailed 

explanation about Review Tab in Microsoft Word is given below. 

 Proofing 

 Comments 

 Tracking 

 Changes 

 Compare 

 Protect 

 



  

8.VIEW TAB 

View Tab in Microsoft Word is use for changing the layouts of the pages, 

show/hide elements such as – ruler or grid-lines, adjusting pages with zoom 

option, working with multiple windows and recording a macro etc. The ribbon of 

View Tab in Microsoft Word is divided into multiple sections with the name 

Document Views, Show/Hide, Zoom, Window and Macros. The detailed 

explanation about View Tab in Microsoft Word is given below. 
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MS EXCEL 

Introduction to Microsoft Excel: 

Microsoft Excel is an electronic spreadsheet. You can use it to organize your data 

into rows and columns. You can also use it to perform mathematical calculations 

quickly. Excel is a spreadsheet program that allows you to store, organize, and 

analyze information. 

1) Calculation: 

In Excel, a formula is an expression that operates on values in a range of cells 

or a cell. For example, =A1+A2+A3, which finds the sum of the range of values 

from cell A1 to cell A3. 

2) Mathematical Function: 

 SUM: It returns the sum of numeric values in a cell. You can refer to the 

cells where you have values or simply insert the values into the function. 



  

 MAX & MIN: The MAX and MIN functions help in finding the maximum 

number and the minimum number in a range of values. 

 AVERAGE: It returns the average of numeric values in a cell. You can refer 

to the cells where you have values or simply insert the values into the 

function. 

 COUNT: It returns the count of numeric values in a cell. You can refer to the 

cells where you have values or simply insert the values into the function 

 COUNTA: It is Like the COUNT function, COUNTA counts all cells in a given 

rage. However, it counts all cells regardless of type. That is, unlike COUNT 

that only counts numeric, it also counts dates, times, strings, logical values, 

errors, empty string, or text. 

 COUNTBLANK: This function is a premade function in Excel, which counts 

blank cells in a range. 

 

3) Logical Function: 

 IF: This function returns a value when the specific condition is TRUE and 

returns another value it condition is FALSE. The IF function is often used 

when you want to sort your data according to a given logic. The best part of 

the IF formula is that you can embed formulas and function in it. 

 SUMIF: You use the SUMIF function to sum the values in a range that meet 

criteria that you specify. The SUMIF function syntax has the following 

arguments: 

 COUNTIF: This function is used for counting cells within a specified range 

that meet a certain criterion, or condition. there are only 2 arguments, both 

of which are required: 

 

4) Charts : 

Charts are visual representations of data used to make it more understandable. 

Commonly used charts are: 

5) Sparkline: 

Sparklines are tiny charts that reside in a cell in Excel. These charts are used to 

show a trend over time or the variation in the dataset. You can use these 



  

sparklines to make your bland data look better by adding this layer of visual 

analysis. In Excel, there are three types of sparklines: 

 

6) Sort: 

The Excel SORT function sorts the contents of a range or array in ascending or 

descending order. Values can be sorted by one or more columns. SORT returns a 

dynamic array of results. 

7) Sub-Total: 

Use Excel's built-in Subtotal feature to automatically add subtotals and grand 

totals to a worksheet list of data, show and hide details. Subtotal pros and cons. 

Fix problem of duplicate grand totals. 

8) Freezing: 

When working with large datasets in Excel, you may often want to lock certain 

rows or columns so that you can view their contents while scrolling to another 

area of the worksheet. This can be easily done by using the Freeze 

Panes command and a few other features of Excel. 

9) Auto Filter: 

Excel AutoFilter is an easy way to turn the values in Excel columns into specific 

filters based on the cell content. Excel AutoFilter allows us to slice and dice our 

data per our requirements. We can filter based on our choices from a list or 

search for the specific data we want to find. The rows which do not meet the 

criteria of the filters will be hidden. In simple words, AutoFilter in Excel allows us 

to view specific rows in Excel while hiding the other rows. When Excel AutoFilter 

is added to the row’s header, it gives us a drop-down menu in the header row.  

10) Advance Filter: 

Excel's Advanced Filter is really helpful when it comes to finding data that meets 

two or more complex criteria such as extracting matches and differences between 



  

two columns, filtering rows that match items in another list, finding exact 

matches including uppercase and lowercase characters, and more.    

11) Conditional Formatting 

As the name suggests, conditional formatting is a type of formatting that is 

applied to cells or ranges when certain conditions are met. These conditions are 

set, but can quite often be customised and edited, in rules that have been 

programmed into Excel. 

 

MS POWERPOINT 

Introduction to PowerPoint: 

Microsoft PowerPoint is a professional presentation program that allows the user 

to create "presentation slides" that can be displayed on the computer screen or 

through a projector that is plugged into the computer.  

1) Home Tab 

The Home Tab in Microsoft PowerPoint contains all the necessary commands 

for inserting and editing slides in a presentation. It usually contains shortcuts 

to some of the most commonly used features that are available in other tabs in 

PowerPoint. 

 

 Clipboard: 

The Clipboard group is the first group in the PowerPoint Home tab. It contains 

the cut and the paste functions: 

 Slides: 

Slides in PowerPoint are crucial to making any presentation. Thus, 

the Slides group in the Home menu includes five commands which are all 

dedicated to adding slides, removing slides, and changing the layout of the slides. 

https://artofpresentations.com/slides-in-powerpoint/


  

 Font: 

This group contains all the functions related to the fonts in PowerPoint. The 

commands in the Fonts group are primarily used for editing the text in a text 

box of a slide. 

 Paragraph: 

The Paragraph group in the Home tab contains functions to edit paragraphs or 

text within a text box. 

 Drawing Group:  

 Editing Group 

 

2) Insert Tab  

 Tables: 

 Illustrations: 

 Text: 

 

3) Design Tab: 

 Page Setup: 

 Themes: 

 Background: 

4) Transition Tab: 

Transitions are animations that you can use when advancing from one slide to 

the next during a presentation. They can be fun, but be careful not to overdo it 

with complicated transitions because they can become distracting. 

  Effect Options:  

 Timing: 



  

5) Animation Tab 

In PowerPoint, you can animate text and objects such as clip art, shapes, and 

pictures. Animation or movement on the slide can be used to draw the audience's 

attention to specific content or to make the slide easier to read. 

 The four types of animations: 

 Effect options 

 Timing  

6) Slide Show Tab: 

 Start Slide Show 

 Set Up 

 Monitors 

 

7)  Review Tab 

 Proofing 

 Comments 

8) View Tab 

 Presentation Views 

 Show/Hide 

 Zoom 

 Color/Gray scale 

 Window 

 Macros 

 

 

 

 



  

INTERNET 
The Internet is a global network of billions of computers and other electronic 

devices. With the Internet, it's possible to access almost any information, 

communicate with anyone else in the world, and do much more. 

One of the best features of the Internet is the ability to communicate almost 

instantly with anyone in the world. Email is one of the oldest and most universal 

ways to communicate and share information on the Internet, and billions of 

people use it. Social media allows people to connect in a variety of ways and build 

communities online 
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https://edu.gcfglobal.org/en/email101
https://edu.gcfglobal.org/en/topics/socialmedia

